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How to Compare Two Sheets in Excel for Matches Comparing two sheets in Excel for matches is easier than you think! You can use features like Conditional Formatting, VLOOKUP, or a simple formula to identify matching data. This way, you can quickly see which values are the same in both sheets and make better decisions based on that
information. Ready to dive in? Let’s get started with the step-by-step guide! Step-by-Step Tutorial on How to Compare Two Sheets in Excel for Matches In this tutorial, you’ll learn different methods to compare two Excel sheets to find matching entries. Each method has its own benefits, so you can choose the one that fits your needs best. Step 1: Open
Both Sheets Open both Excel sheets that you want to compare. Make sure you have access to both sheets in the same Excel workbook or separate workbooks. This will make it easier to switch between them. Step 2: Use Conditional Formatting Go to the first sheet and select the range of cells you want to compare. Then, go to the "Home" tab, click on
"Conditional Formatting," and choose "New Rule." In the dialog box, select "Use a formula to determine which cells to format." Enter a formula like =A1=Sheet2!A1l and choose a formatting style to highlight matches. Press OK to apply. Step 3: Apply VLOOKUP Function Click on the cell where you want to display the results of the comparison. Enter
the VLOOKUP formula: =VLOOKUP(A1,Sheet2!A:A,1,FALSE). This function will look up the value in Al in the second sheet and return the matching value. If there is no match, it will return an error. Drag the fill handle to apply the formula to other cells. Step 4: Use IF Function Select the cell where you want to see the comparison result. Enter the
formula: =IF(A1=Sheet2!A1, "Match", "No Match"). This function compares the value in Al of the first sheet with Al of the second sheet. It returns "Match" if they are the same and "No Match" if they are different. Drag the fill handle to apply the formula to other cells. Step 5: Check Results Review the highlighted cells or the result of the formulas to
see which values match between the two sheets. Make a note of any discrepancies or patterns you observe. You can use this information to make further decisions or adjustments to your data. After you've finished comparing the sheets, you will have a clear view of which values match and which do not. This can be incredibly helpful for data analysis,
inventory management, or any other task that requires data comparison. Tips for Comparing Two Sheets in Excel for Matches Use Named Ranges: Instead of selecting cell ranges, use named ranges for easier reference in your formulas. Filter Data: Use filters to quickly zero in on cells with matches or discrepancies. Backup Your Data: Always make a
backup of your Excel files before performing comparisons. Use Absolute References: When writing formulas, use absolute references to lock the cell references. Keep Data Consistent: Ensure that data types and formats are consistent across both sheets for accurate comparison. Frequently Asked Questions What if my data is in different columns? You
can adjust the cell references in your formulas to match the exact columns where your data is located. Can I compare more than two sheets? Yes, you can compare multiple sheets by extending your formulas or using tools like Power Query. What if my data contains duplicates? You can use Excel’s "Remove Duplicates" feature to clean up your data
before comparing. How do I compare large datasets? For large datasets, consider using Excel’s "Find & Select" feature or pivot tables to manage and compare data more efficiently. Can I automate this process? Yes, you can use Excel macros to automate the comparison process, saving you time and effort. Summary Open both sheets. Use Conditional
Formatting. Apply VLOOKUP function. Use IF function. Check results. Conclusion Comparing two sheets in Excel for matches is a straightforward task when you know the right techniques. Whether you use Conditional Formatting, VLOOKUP, or the IF function, each method helps you identify matching values efficiently. Remember, the key is to
understand your data and choose the method that best fits your needs. With these tips and FAQs, you’'re now equipped to handle any data comparison task in Excel. So, why wait? Dive into your worksheets and start comparing. Your data insights are just a few clicks away! Matt Jacobs has been working as an IT consultant for small businesses since
receiving his Master’s degree in 2003. While he still does some consulting work, his primary focus now is on creating technology support content for SupportYourTech.com. His work can be found on many websites and focuses on topics such as Microsoft Office, Apple devices, Android devices, Photoshop, and more. In this tutorial, you will learn a
variety of methods to compare Excel files and identify differences between them. See how to open two Excel windows side by side, how to use Excel formulas to create a difference report, highlight differences with conditional formatting, and more. When you have two similar Excel workbooks, or better say two versions of the same workbook, what's
the first thing you usually want to do with them? Right, compare those files for differences, and then probably merge them into a single file. In addition, workbook comparison can help you spot potential problems like broken links, duplicate records, inconsistent formulas or wrong formatting. So, let's have a closer look at various methods to compare
two Excel sheets or entire workbooks and identify differences between them. If you have relatively small workbooks and a sharp eye for detail, this quick and easy way to compare Excel files might work well for you. I am talking about View Side by Side mode that lets you arrange two Excel windows side by side. You can use this method to visually
compare two workbooks or two sheets in the same workbook. Let's say you have sales reports for two months and you want to view both of them simultaneously to understand which products performed better this month and which did better last month. To open two Excel files side by side, do the following: Open the workbooks you want to compare.
Go to the View tab, Window group, and click the View Side by Side button. That's it! By default, two separate Excel windows are displayed horizontally. To split Excel windows vertically, click Arrange All button and select Vertical: As the result, two separate Excel windows will be arranged side by side, like in the below screenshot. If you want to scroll
through both worksheets simultaneously to compare data row-by-row, make sure the Synchronous Scrolling option it turned on. This option resides on the View tab, in the Window group, right under the View Side by Side button, and is usually turned on automatically as soon as you activate View Side by Side mode. For more information about using
this Excel feature, please see View Excel workbooks side by side. To view more than 2 Excel files at a time, open all the workbooks you want to compare, and click the View Side by Side button. The Compare Side by Side dialog box will appear, and you select the files to be displayed together with the active workbook. To view all open Excel files at a
time, click the Arrange All button on the View tab, in the Window group, and choose your preferred arrangement: tiled, horizontal, vertical or cascade. Sometimes, 2 sheets that you want to compare reside in the same workbook. To view them side by side, perform the following steps. Open your Excel file, go to the View tab > Window group, and click
the New Window button. This will open the same Excel file in a different window. Enable View Side by Side mode by clicking the corresponding button on the ribbon. Select sheet 1 in the first window and sheet 2 in the second window. It is the simplest way to compare data in Excel that lets you identify cells with different values. As the result, you will
have a difference report in a new worksheet. To compare two Excel worksheets for differences, just open a new empty sheet, enter the following formula in cell A1, and then copy it down and to the right by dragging the fill handle: =IF(Sheet1!A1 Sheet2!Al, "Sheetl:"&Sheet1!A1&" vs Sheet2:"&Sheet2!Al, "") Due to the we use of relative cell
references, the formula will change based on a relative position of the column and row. As the result, the formula in A1 will compare cell Al in Sheetl and Sheet2, the formula in B1 will compare cell B1 in both sheets, and so on. The result will look similar to this: As you can see in the above screenshot, the formula compares 2 sheets, identifies cells
with deferent values and displays the differences in corresponding cells. Please note that in the difference report, dates (cell C4) are presented by serial numbers as they are stored in the internal Excel system, which is not very convenient for analyzing differences between them. To highlight cells that have different values in two sheets with the color
of your choosing, use the Excel conditional formatting feature: In the worksheet where you want to highlight differences, select all used cells. For this, click the upper left cell of the used range, usually Al, and press Ctrl + Shift + End to extend the selection to the last used cell. On the Home tab, in the Styles group, click Conditional Formatting >
New rule, and create a rule with the following formula: =A1Sheet2!A1 Where Sheet2 is the name of the other sheet you are comparing. As the result, the cells with different values will get highlighted with the selected color: If you are not very familiar with Excel conditional formatting, you can find the detailed steps to create a rule in the following
tutorial: Excel conditional formatting based on another cell value. As you see, it's very easy to compare two Excel sheets by using formulas or conditional formats. However, these methods are not well suited for all-round comparison because of the following limitations: They find differences only in values, but cannot compare formulas or cell
formatting. They cannot identify added or deleted rows and columns. As soon as you add or delete a row / column in one sheet, all subsequent rows / columns will be marked as differences. They work on a sheet level, but cannot detect workbook-level structural differences such as sheet additions and deletions. When it comes to merging different
versions of the same Excel file, the Compare and Merge feature comes in handy. It is especially useful when several users collaborate on the same Excel workbook because it lets you view the changes and comments of all users at a time. To leverage this feature, be sure to do the following preparations: Share your Excel workbook before you make it
available to other users. To share a workbook, just click the Share Workbook button on the Review tab, in the Changes group, select the Allow Changes by More Than One User... box, and click OK. Allow Excel to save the workbook if prompted. Turning on the Track Changes feature shares the workbook automatically. Each person who makes any
edits to the shared workbook must save a copy (.xls or xIsx file) using a unique file name. Now that all initial preparations are done properly, you are ready to combine the copies of a shared workbook. Although, the Compare and Merge Workbooks feature is available in all versions of Excel 2010 through Excel 365, this command is not displayed
anywhere in Excel by default. To add it to the Quick Access toolbar, perform the following steps: Open the Quick Access drop down menu and select More Commands. In the Excel Options dialog box, select All Commands under Choose commands from. In the list of commands, scroll down to Compare and Merge Workbooks, select it and click the Add
button to move it to the right-hand section. Click OK. When all of the users have finished working with your shared Excel workbook, you can merge all the copies into one file. Open the primary version the shared workbook. Click the Compare and Merge Workbooks command on the Quick Access toolbar. In the dialog box that appears, select a copy of
the shared workbook that you want to merge. To select several copies, hold the Shift key while clicking the file names, and then click OK. Done! The changes from each copy are merged into a single workbook. To see all the edits by different users at a glance, just do the following: Switch to the Review tab > Changes group, and click Track Changes >
Highlight Changes. In the Highlight Changes dialog, select All in the When box, Everyone in the Who box, clear the Where box, select the Highlight changes on screen box, and click OK. To point out the row and columns with differences, Excel highlights the column letters and row numbers in a dark red color. At the cell level, edits from different
users are marked with different colors. To see who made a specific change, just hover over the cell. Note. If the Compare and Merge Workbooks command is greyed out in your Excel, most likely you are trying to combine different Excel files. Please remember, the Compare and Merge Workbooks feature allows merging only copies of the same shared
workbook. As you have just seen, Microsoft Excel provides a handful of features to compare data in two or more workbooks. But none of the built-in options is sufficient to comprehensively compare Excel sheets, let alone entire workbooks, spotting all the differences in values, formulas or formatting. So, if you need advanced and really efficient means
to compare two Excel files, then most likely you would have to use one of the third-party tools specially designed for comparing, updating and merging Excel sheets and workbooks. Below you will find a quick overview of a few tools that, in my opinion, are best performers in this area. The Synkronizer Excel Compare add-in can quickly compare,
merge and update two Excel files saving you the trouble of searching for differences manually. If you are looking for a quick and reliable method to compare two Excel sheets or workbooks, you will certainly find helpful the following features of Synkronizer Excel Compare: Identifying the differences between two Excel sheets. Combining multiple
Excel files into a single version without producing unwanted duplicates. Highlighting the differences in both sheets. Showing only the differences that are relevant to your task. Merging and updating the sheets. Presenting detailed and easy to read difference reports. To get some basic idea about Synkronizer Excel Compare's capabilities and
performance, let's carry out a couple of field tests. Supposing you are organizing some event and, in your Excel table, you gather information about the participants such as a participant name, arrival date, number of seats, etc. Also, you have a couple of managers in direct contact with participants and the database, and as a result, you have 2
versions of the same Excel file. Okay, let's see how efficiently Synkronizer can compare our two sheets and identify differences between them. To run Synkronizer Excel Compare, go to the Add-ins tab, and click the Synchronizer 11 icon. The Synkronizer pane will show up in the left part of your Excel window, where you do the following: Select 2
workbooks to compare: Select sheets to compare. If the selected workbooks have any sheets with the same names, all those sheets will be matched and automatically selected for comparison (like Participants sheets in the below screenshot). Also, you can select worksheets manually or instruct the add-in to match sheets by other criteria, for example
by worksheet type - all, protected, or hidden. Once you've selected the sheets, the Synkronizer add-in will open them side by side, arranged vertically or horizontally, like in Excel's View Side by Side mode. Select one of the following comparison options: Compare as normal worksheets - the default option that works in most cases. Compare with link
options - if the selected sheets do not contain any new or deleted rows and columns, you can compare them "1 on 1". Compare as database - recommended for comparing sheets that have a database structure. Compare selected ranges - if you do not want to compare the entire sheets, define the ranges to be compared. Choose the content types to be
compared (optional). On the Select tab, in the Compare group, you can choose the content type(s) relevant to your current task: Under Content, you can select comments and names (in addition to cell values, formulas and calculated values that are compared by default). Under Formats, you choose what cell formats such as alignment, fill, font, border
etc. The Filters option lets you filter out differences that you don't want to display. For example, you can ignore case, leading or trailing spaces, all formulas or different formulas with the same result, hidden rows or column, and more. Finally, click the big red Start button on the ribbon and proceed to examining the results. Usually it takes
Synkronizer only a few seconds to compare 2 sheets and present two summary reports on the Results tab: In a summary report, you can see all difference types at a glance: changes in columns, rows, cells, comments, formats, and names. To view the detailed difference report, just click a specific difference type on the summary report. The following
screenshot shows the summary report (in the upper part of the Results pane), and cell difference report (in the lower part of the pane) that were created for our sample sheets: Clicking on a difference in the detailed report will select the corresponding cells on both sheets (the below screenshot shows just one sheet because there's enough room to
show both :) In addition, you can create a difference repot in a separate workbook, either standard or hyperlinked, and jump to a specific difference with a mouse click: If the two Excel files you are comparing contain multiple sheets, all matching worksheet pairs will be presented in the summary report for your perusal: By default, the Synkronizer
Excel Compare add-in highlights all found differences, like in the following screenshot: Yellow - differences in cell values Lilac - differences in cell formats Green - inserted rows To highlight only the relevant differences, click the Outline button on the Results tab, and select the required options: The merge function is definitely one of the most useful
features of the Synkronizer Excel Compare add-in. You can transfer individual cells or move different columns/rows from the source to target sheet, and have your primary sheet updated in seconds. To update one or more differences, select them on the Synkronizer's pane and click one of the 4 update buttons - the first and last buttons update all
differences, while the 2nd and 3rd buttons update selected differences only (the button arrows indicate the transfer direction): Well, these are the key features of the Synkronizer add-in, but there is certainly much more to it. Want to give it a try? An evaluation version is available for download here. Synkronizer is certainly worth your attention, but
it's not the only way to compare files in Excel. A handful of other comparison tools exist, which basically provide the same set of features but in different implementations. The latest version of our Ultimate Suite includes over 40 new features and improvements, the most exciting of which is Compare Sheets - our own tool to compare worksheets in
Excel. To make the comparison more intuitive and user-friendly, the add-in is designed in this way: A step-by-step wizard walks you through the process and helps configure different options. You can choose the comparison algorithm best suited for your data sets. Instead of a difference report, the compared sheets are displayed in the Review
Differences mode so that you could view all the differences at a glance and manage them one-by-one. Now, let's try the tool on our sample spreadsheets from the previous example and see if the results are any different. Click the Compare Sheets button on the Ablebits Data tab, in the Merge group: The wizard will show up asking you to select the two
worksheets you'd like to compare for differences. By default, the entire sheets are selected, but you can also select the current table or a specific range by clicking the corresponding button: On the next step, you select the comparison algorithm: No key columns (default) - works best for sheet-based documents like invoices or contracts. By key
columns - is appropriate for column-organized sheets that have one or more unique identifiers such as order numbers or product ID's. Cell-by-cell - best to be used to compare spreadsheets with the same layout and size, like balance sheets or year-to-year reports. Tip. If you are unsure which option is right for you, go with the default one (No key
columns). Whichever algorithm you select, the add-in will find all the differences, it will only highlight them differently (entire rows or individual cells). On the same step, you can choose the preferred match type: First match (default) - compare a row in Sheet 1 to the first found row in Sheet 2 that has at least one matching cell. Best match - compare
a row in Sheet 1 to the row in Sheet 2 that has the maximum number of matching cells. Full match only - find rows in both sheets that have exactly the same values in all the cells, and mark all other rows as different. In this example, we will look for Best match by using the default No key columns comparing mode: Finally, specify which differences to
highlight and which to ignore, and how to mark the differences. Cell formatting is important to us, so we select Show differences in formatting. Hidden rows and columns are irrelevant, and we tell the add-in to ignore them: Click the Compare button and allow the add-in a couple of minutes to process your data and make the backup copies. Backups
are always created automatically, so you may not worry about the safety of your data. Once the worksheets are processed, they are opened side-by-side in a special Review Differences mode, with the first difference selected: On the screenshot above, the differences are highlighted with the default colors: Blue rows - rows that exist only in Sheet 1 (on
the left). Red rows - rows that exist only in Sheet 2 (on the right). Green cells - difference cells in partially matching rows. To help you review and manage the differences, each worksheet has its own vertical toolbar. For the inactive worksheet (on the left) the toolbar is disabled. To enable the toolbar, just select any cell in the corresponding sheet. By
using this toolbar, you go through the found differences one-by-one and decide whether to merge or ignore them: As soon as the last difference is dealt with, you will be prompted to save the workbooks and exit the Review differences mode. If you have not finished processing the differences yet but would like to take a break for now, click the Exit
Review Differences button at the bottom of the toolbar and choose either to: Save the changes you've made and remove the remaining difference marks, or Restore the original workbooks from the backup copies. That's how you compare two sheets in Excel with our tool (hope you liked it :) If you are curious to give it a shot, an evaluation version is
available for download here. Using the xICompare utility, you can compare two Excel files, worksheets, names and VBA Projects. It identifies added, deleted and changed data and allows you to quickly merge differences. In addition, it provides the following options: Find duplicate records between two worksheets and remove them. Update all existing
records in one sheet with values from another sheet. Add unique (new) rows and columns from one sheet to another. Merge all updated records from one workbook to another. Sort data on the sheets by the key column. Filter the comparison results to display differences or identical records. Highlight comparison results with colors. With Change pro
for Excel, you can compare two sheets in desktop Excel as well as on mobile devices with optional server-based comparison. The key features of this tool are: Find differences between 2 sheets in formulas and values. Identify layout changes, including added / deleted rows and columns. Recognize embedded objects such as charts, graphs and images.
Create and print difference reports of formula, value and layout differences. Filter, sort, and search the difference report on key changes. Compare files directly from Outlook or document management systems. Support for all languages, including multi-byte. Apart from desktop tools and utilities, there exist a number of online services that let you
quickly compare two Excel sheets for differences without installing any software on your computer. Probably it's not the best solution in terms of security, but if your Excel files do not contain any sensitive information why not use some free online service for immediate results? For example, you can try XLComparator or CloudyExcel, or find some
other similar services on the net. This is how the CloudyExcel service looks like: You just upload the two Excel workbooks you want to compare, and click the Find Difference button at the bottom of the screen. In a moment, the differences in two active sheets will get highlighted with different colors: Well, this is how you can compare Excel files for
differences. If none of the solutions described in this tutorial is suitable for your task, check out the following resources that cover other aspects of Excel file comparison. And if you know any other ways to compare two Excel files, your comments will be greatly appreciated. I thank you for reading and hope to see you on our blog next week! But don’t
worry, we will see how to deal with this later. First things first, we will locate the name of our worksheet. To do that, Step 1) Open the sheet you want to extract the name of and select a cell. Step 2) Type in the following CELL formula in any cell Syntax Highlighter=CELL("filename",A1) Make sure your file is saved before you apply the formula, or it
will return a blank value The CELL function returns the full path where the file is stored and the name of the worksheet we are currently in. Now, to apply the TEXTAFTER function, Step 4) Select a cell in the worksheet. Step 5) Type in the following formula Syntax Highlighter=TEXTAFTER(B10, “]”)Or you can directly write the formula as Syntax
Highlighter=TEXTAFTER(CELL("filename",Al), “]1”)Step 6) Press Enter. The formula will return the current sheet name as: Do the same for all four sheets. Simply copy the formula from the formula bar and paste it one by one on all sheets. Then, list them in the Summary sheet. To do that, Step 1) Select cell A2. Step 2) Type = in the cell. Step 3) Click
on the tab you want to reference. Step 4) Select the cell containing the name of the sheet. Excel returns the name of the tab in the Summary sheet. Since this formula is dynamic, the name will change here if you rename the sheet. Repeat the same process for the remaining sheets and it’'s done @ Let’s now see another way of finding the sheet name.
It works the same as the TEXTAFTER function but is just a variation of the same for Excel users who have other Excel subscriptions. To find tab names, we will use the combination of MID and FIND Excel functions for this method, where the MID function returns the characters at the middle of a string, and FIND locates and returns that string The
syntaxes of the two functions are given below: Syntax Highlighter=MID(text,start num,num_chars)where, textrefers to the text from which the substring is to be extracted start num refers to the starting position of the substring - the +1 tells the function to start reading immediately after the character criteria num_chars refers to the number of
characters to read. Syntax HighlighterFIND(find text, within text, [start num])where, find text refers to the string to be found within text refers to the string to be found within Let’s now implement this function below. Step 1) Select any cell in the worksheet. Step 2) Type in the following formula Syntax
Highlighter=MID(CELL("filename",A1),FIND("]",CELL("filename",A1))+1,31)In this formula, the first argument gives the MID function the string where it has to get the sheet name, the second argument a square bracket tells the function it has to look for this and begin reading after it. The last argument is the number of characters the name of a
worksheet can be, i.e. 31. Step 3) Press Enter. It returns the name of the active sheet, i.e. Salary. If you were to copy this formula and paste it into another sheet to extract the name of that tab, the name in the previous sheet wouldn’t change owing to the cell reference we added. However, if we were to skip the cell reference parameter in this
formula, when we paste the formula to another sheet, its previous copy will reflect the new changes too Paste the formula without the cell reference to the Address sheet. Go back to the Salary sheet. As said, the worksheet name in the previous file has now changed to that of the new one. This error can get tricky to debug and mess up the working of
your sheet if omitted accidentally. Make sure to double-check once you’re done writing the formula. Now, following the same method as above, list all these values in the Summary sheet and you’'re good to go. Try it yourself! © The above formula also caters to instances where your sheet name has space or other special characters. The SEARCH
function is slightly longer than the FIND function but returns the same result. The only leverage you have here is if you have sheets of varying lengths, the LEN function here can be helpful in that @ It uses a combination of the RIGHT, LEN, and SEARCH functions. The syntaxes of these functions are as below: Syntax Highlighter=RIGHT(text,

[num chars])where text refers to the string to be extracted num chars refers to the number of characters to read from right and, Syntax Highlighter=LEN(text)where, text is the string whose length is to be returned and, Syntax Highlighter=SEARCH( search text, within text, [start num])where, search text refers to the string to be searched

within text refers to the string to be searched within Now, to implement this function, Step 1) Select a cell in your sheet. Step 2) Type in the following formula Syntax Highlighter=RIGHT(CELL("filename",D2),LEN(CELL("filename",D2))-SEARCH("]",CELL("filename",D2)))In this formula, the RIGHT function takes in the full path and places the cursor
at the end. The LEN function returns the length of the path and the SEARCH function looks for the right square bracket in the string. Once found, the length of characters before the square bracket is subtracted from the total path length and the RIGHT function then reads the sheet name from the end. Step 3) Press Enter The function returns the
current sheet name,i.e. Contact The same is true if your sheet name consists of spaces or other characters. This formula can be a little tricky to get around but once you do, referencing your sheet name in Excel is going to be easy In this article, we saw three different formulas that you can use to reference a tab name in your worksheet. These
included the TEXTAFTER and combinations of FIND and SEARCH functions Being able to reference tabs and sheets in formulas is an essential skill in data manipulation and is very useful if data analysis is your day-to-day task You can learn more about these functions below Excel Functions LEFT, RIGHT, MID, and LEN for Substrings Excel SEARCH
and FIND Functions: Step-by-Step Guide (2024) How to Rename a Sheet in Excel: Step-by-Step Guide (2024) We hope you enjoyed reading this article as much as we enjoyed creating it. Watch Video - How to Compare Two Excel Sheets for Differences Comparing two Excel files (or comparing two sheets in the same file) can be tricky as an Excel
workbook only shows one sheet at a time. This becomes more difficult and error-prone when you have a lot of data that needs to be compared. Thankfully, there are some cool features in Excel that allow you to open and easily compare two Excel files. In this Excel tutorial, I will show you multiple ways to compare two different Excel files (or sheets)
and check for differences. The method you choose will depend on how your data is structured and what kind of comparison you’'re looking for. Let’s get started! Compare Two Excel Sheets in Separate Excel Files (Side-by-Side) If you want to compare two separate Excel files side by side (or two sheets in the same workbook), there is an in-built feature
in Excel to do this. It’s the View Side by Side option. This is recommended only when you have a small dataset and manually comparing these files is likely to be less time-consuming and error-prone. If you have a large dataset, I recommend using the conditional method or the formula method covered later in this tutorial. Let’s see how to use this
when you have to compare two separate files or two sheets in the same file. Suppose you have two files for two different months and you want to check what values are different in these two files. By default, when you open a file, it’s likely to take up your entire screen. Even if you reduce the size, you always see one Excel file at the top. With the view
side-by-side option, you can open two files and then arrange these horizontally or vertically. This allows you to easily compare the values without switching back and forth. Below are the steps to align two files side by side and compare them: Open the files that you want to compare. In each file, select the sheet that you want to compare. Click the
View tab In the Windows group, click on the ‘View Side by Side’ option. This becomes available only when you have two or more Excel files open. As soon as you click on the View side by side option, Excel will arrange the workbook horizontally. Both of the files will be visible, and you’re free to edit/compare these files while they are arranged side by
side. In case you want to arrange the files vertically, click on the Arrange All option (in the View tab). This will open the ‘Arrange Windows’ dialog box where you can select ‘Vertical’. At this point, if you scroll down in one of the worksheets, the other one would remain as is. You can change this so that when you scroll in one sheet, the other also
scrolls at the same time. This makes it easier to do a line by line comparison and spot any differences. But to do this, you need to enable Synchronous Scrolling. To enable Synchronous Scrolling, click on the View tab (in any of the workbooks) and then click on the Synchronous Scrolling option. This is a toggle button (so if you want to turn it off, simply
click on it again). Comparing Multiple Sheets in Separate Excel Files (Side-by-Side) With the “View Side by Side’ option, you can only compare two Excel file at one go. In case you have multiple Excel files open, when you click on the View Side by Side option, it will show you a ‘Compare Side by Side’ dialog box, where you can choose which file you
want to compare with the active workbook. In case you want to compare more than two files at one go, open all these files and then click on the Arrange All option (it’s in the View tab). In the Arrange Windows dialog box, select Vertical/Horizontal and then click OK. This will arrange all the open Excel files in the selected order (vertical or horizontal).
Compare Two Sheets (Side-by-Side) in the Same Excel Workbook In case you want to compare two separate sheets in the same workbook, you can’t use the View side by side feature (as it works for separate Excel files only). But you can still do the same side-by-side comparison. This is made possible by the ‘New Windows’ feature in Excel, that allows
you to open two instances on the same workbook. Once you have two instances open, you can arrange these side by side and then compare these. Suppose you have an Excel workbook that has two sheets for two different months (Jan and Feb) and you want to compare these side by side to see how the sales per store have changed: Below are the
steps to compare two sheets in Excel: Open the workbook that has the sheets that you want to compare. Click the View tab In the Window group, click on the ‘New Window’ option. This opens the second instance of the same workbook. In the "View’ tab, click on ‘Arrange All’. This will open the Arrange Windows dialog box Select ‘Vertical’ to compare
data in columns (or select Horizontal if you want to compare data in rows). Click OK. The above steps would arrange both the instances of the workbook vertically. At this point in time, both the workbooks would have the same worksheet selected. In one of the workbooks, select the other sheet that you want to compare with the active sheet. How
does this work? When you click on New Window, it opens the same workbook again with a slightly different name. For example, if your workbook name is ‘Test’ and you click on New Window, it will name the already open workbook ‘Test - 1’ and the second instance as ‘Test - 2’. Note that these are still the same workbook. If you make any changes in
any of these workbooks, it would be reflected in both. And when you close any one instance of the open file, the name would revert back to the original. You can also enable synchronous scrolling if you want (by clicking on the ‘Synchronous Scrolling’ option in the View’ tab) Compare Two Sheets and Highlight Differences (Using Conditional
Formatting) While you can use the above method to align the workbooks together and manually go through the data line by line, it’s not a good way in case you have a lot of data. Also, doing this level of comparison manually can lead to a lot of errors. So instead of doing this manually, you can use the power of Conditional Formatting to quickly
highlight any differences in the two Excel sheets. This method is really useful if you have two versions in two different sheets and you want to quickly check what has changed. Note that you CAN NOT compare two sheets in different workbooks. Since Conditional Formatting can not refer to an external Excel file, the sheets you need to compare needs
to be in the same Excel workbook. In case these aren’t, you can copy a sheet from the other file to the active workbook and then make this comparison. For this example, suppose you have a dataset as shown below for two months (Jan and Feb) in two different sheets and you want to quickly compare the data in these two sheets and check if the prices
of these items have changed or not. Below are the steps to do this: Select the data in the sheet where you want to highlight the changes. Since I want to check how prices have changed from Jan to Feb, I have selected the data in the Feb sheet. Click the Home tab In the Styles group, click on ‘Conditional Formatting’ In the options that show up, click
on ‘New Rule’ In the ‘New Formatting Rule’ dialog box, click on ‘Use a formula to determine which cells to format’ In the formula field, enter the following formula: =B2Jan!B2 Click the Format button In the Format Cells dialog box that shows up, click on the ‘Fill tab’ and select the color in which you want to highlight the mismatched data. Click OK
Click OK The above steps would instantly highlight any changes in the dataset in both the sheets. How does this work? Conditional formatting highlights a cell when the given formula for that cell returns a TRUE. In this example, we are comparing each cell in one sheet with the corresponding cell in the other sheet (done using the not equal to
operator in the formula). When conditional formatting finds any difference in the data, it highlights that in the Jan sheet (the one in which we have applied the conditional formatting. Note that I have used relative reference in this example (Al and not $A$1 or $A1 or A$1). When using this method to compare two sheets in Excel, remember the
following; This method is good to quickly identify differences, but you can’t use it on an on-going basis. For example, if I enter a new row in any of the datasets (or delete a row), it would give me incorrect results. As soon as I insert/delete the row, all subsequent rows are considered as different and highlighted accordingly. You can only compare two
sheets in the same Excel file You can only compare the value (not the difference in formula or formatting). Compare Two Excel Files/Sheets And Get The Differences Using Formula If you’'re only interested in quickly comparing and identifying the differences between two sheets, you can use a formula to fetch only those values that are different. For
this method, you will need to have a separate worksheet where you can fetch the differences. This method would work if want to compare two separate Excel workbook or worksheets in the same workbook. Let me show you an example where I am comparing two datasets in two sheets (in the same workbook). Suppose you have the dataset as shown
below in a sheet called Jan (and similar data in a sheet called Feb), and you want to know what values are different. To compare the two sheets, first, insert a new worksheet (let’s call this sheet ‘Difference’). In cell Al, enter the following formula: =IF(Jan!A1Feb!A1,"Jan Value:"&Jan!A1&CHAR(10)&"Feb Value:"&Feb!Al,"") Copy and paste this
formula for a range so that it covers the entire dataset in both the sheets. Since I have a small dataset, I will only copy and paste this formula in A1:B10 range. The above formula uses an IF condition to check for differences. In case there is no difference in the values, it will return blank, and in case there is a difference, it will return the values from
both the sheets in separate lines in the same cell. The good thing with this method is that it only gives you the differences and show you exactly what the difference is. In this example, I can easily see that the price in cell B4 and B8 are different (as well as the exact values in these cells). Compare Two Excel Files/Sheets And Get The Differences Using
VBA If you need to compare Excel files or sheets quite often, it’'s a good idea to have a ready Excel macro VBA code and use it whenever you need to make the comparison. You can also add the macro to the Quick Access Toolbar so that you can access with a single button and instantly know what cells are different in different files/sheets. Suppose you
have two sheets Jan and Feb and you want to compare and highlight differences in the Jan sheet, you can use the below VBA code: Sub CompareSheets() Dim rngCell As Range For Each rngCell In Worksheets("Jan").UsedRange If Not rngCell = Worksheets("Feb").Cells(rngCell. Row, rngCell.Column) Then rngCell.Interior.Color = vbYellow End If Next
rngCell End Sub The above code uses the For Next loop to go through each cell in the Jan sheet (the entire used range) and compares it with the corresponding cell in the Feb sheet. In case it finds a difference (which is checked using the If-Then statement), it highlights those cells in yellow. You can use this code in a regular module in the VB Editor.
And if you need to do this often, it’s better to save this code in the Personal Macro workbook and then add it to the Quick Access toolbar. In those ways, you will be able to do this comparison with a click of a button. Here are the steps to get the Personal Macro Workbook in Excel (it’s not available by default so you need to enable it). Here are the
steps to save this code in the Personal Macro Workbook. And here you will find the steps to add this macro code to the QAT. Using a Third-Party Tool - XL. Comparator Another quick way to compare two Excel files and check for matches and differences is by using a free third-party tool such as XL. Comparator. This is a web-based tool where you can
upload two Excel files and it will create a comparison file that will have the data that is common (or different data based on what option you selected. Suppose you have two files that have customer datasets (such as name and email address), and you want to quickly check what customers are there is file 1 and not in file 2. Below is how you compare
two Excel files and create a comparison report: Open Use the Choose file option to upload two files (maximum size of each file can be 5MB) Click on the Next button. Select the common column in both these files. The tool will use this common column to look for matches and differences Select one of the four options, whether you want to get matching
data or different data (based on File 1 or File 2) Click on Next Download the comparison file which will have the data (based on what option you selected in step 5) Below is a video that shows how XL. Comparator tool works. One concern you may have when using a third-party tool to compare Excel files is about privacy. If you have confidential data
and privacy is really important for it, it’s better to use other methods shown above. Note that the XIL. Comparator website mentions that they delete all the files after 1 hour of doing the comparison. These are some of the methods you can use to compare two different Excel files (or worksheets in the same Excel file). Hope you found this Excel tutorial
useful. You may also like the following Excel tutorials: There are many reasons why you may need to compare Excel files, such as ensuring data integrity and consistency and data analysis. This can be quite difficult if you have to keep switching between windows, especially when dealing with large datasets or collaborating with multiple stakeholders.
Excel offers a myriad of possibilities for comparing two Excel files and identifying the differences between them. In this guide, we will walk you through step-by-step instructions for how to compare two Excel files. Read on to learn more. How to Compare Two Excel Files for Differences There are various methods you can use to compare files in Excel
for differences. These include: Using View side by side Using formulas Using Spreadsheet Compare Add-in Using Third-party Tools For this tutorial, we’ll be using the example workbooks below: Let’s look at these methods. Compare Two Excel Files For Differences Using View Side By Side Unlike Google Sheets, Excel has a built-in feature called view
side by side that lets you do just that; view Excel files side by side. Here’s how to compare two Excel spreadsheets using view side by side: Go to Excel and open all the workbooks you want to compare. You can do this by going to File > Open and then selecting the workbooks. Go to the View tab and select View side by side. Your Excel window will be
split into 2 horizontally so that you can view the two windows together. If you want the windows to split vertically instead, then you can click on the option for Arrange all. Then choose the vertical option in the pop-up. There are more options to make this feature work seamlessly, for example: Simultaneous scroll- This lets you scroll up and down both
windows at the same time. Freeze pane- This lets you freeze the two rows so that they don’t move while you scroll. Reset Window Position- This lets you change the comparison orientation back to landscape format. Compare Excel Files For Differences Using Formulas IF is a powerful function that has many uses, and one of them is to compare files.
When using formulas to compare Excel files, you'll need to open a blank new document that will be used to transfer all the differences. To compare Excel files for differences using the IF formula, follow these steps: Open both worksheets and enable view side by side Open a New sheet in one of the workbooks by clicking the + sign at the bottom. In
the new sheet, enter the following: =IF(Sheet1!A3=[Book1.xlsx]Sheet1!$A$3,Sheet1!A3,"Sheetl:"&Sheetl1!A3&"|Sheet2:"&[Bookl.xlsx]Sheetl1!A3) You may need to adjust this formula based on the cell references, sheet names and file names of your workbooks. Copy the IF formula down the column by dragging down the small square on the bottom
right of the cell to cover all the rows you want to compare. This formula works by returning the values from both sheets in separate lines in the same cell. The limitations to using this formula are that you can only compare two sheets, and you can only compare the values in those sheets. You can also use the VLOOKUP to compare different Excel
sheets or files. Compare Excel Files For Differences Using Spreadsheet Compare Add-in: There are plenty of add-ins in Excel that help make your life easier. One such tool is the Spreadsheet Compare add-in. This add-in lets you easily compare Excel files by analyzing them and giving you a summary of the differences in the files. Here’s how to use it:
First, turn on the Inquire tab. Go to File> Options and select Add-ins in the sidebar. Go to the drop-down for Manage and choose COM Add-in and click Go. In the new prompt, check the box for Inquire and click Ok. Open the two Excel files you want to compare. Go to the Inquire tab, and select Compare Files. Your files will automatically appear. Click
Swap files, then click Compare. The Spreadsheet Compare window will open, showing an analysis of the comparison between the 2 files. Keep in mind that Spreadsheet Compare is only available for certain versions of Microsoft Office, including Office Professional Plus 2013, Office Professional Plus 2016, Office Professional Plus 2019, and Microsoft
365 Apps for Enterprise. Compare Excel Files For Differences Using Third-Party Tools Third-party tools can be pretty useful and convenient tools if you find the right ones. There are a number of third-party tools whose function is to compare Excel files. If you don’t have any of the Microsoft versions mentioned, then you can use an online tool like
xlcomparator.net Open xlcomparator.net Click Choose Files to upload your 2 Excel files Click on the Next button. Select the columns you want to compare using the file columns drop-down. Select one of the four options, whether you want to get matching data or different data. Click on Next Download the comparison file. The comparison file will
show you the difference between the Excel files. Note that we recommend using an online tool as opposed to the software you need to download since it may not be safe to use and can harm your device. How to Compare Two Excel Sheets And Highlight the Differences To make it easier for you to see the differences between your 2 Excel files, you can
also use conditional formatting to highlight the differences in one of the worksheets: Open your two Excel worksheets. Go to the spreadsheet where you want the differences to be shown and select the data range. On the Home tab, click the Conditional Formatting drop-down. Choose the option “ Use a formula to determine which cells to format” and
enter the formula below in the text box =A1Sheet2!A1 Where Sheet 2 is the name of the other sheet you are comparing. In the new window, go to Fill and choose the color you want to use to highlight the differences. Once you’re done, click OK. As a result, the cells with different values will be highlighted in the cell you put the conditional formatting
in while the cells that are similar will remain the same. This will help you easily spot the differences when viewing the two Exel files. How to Compare and Merge Copies of a Shared Workbook Excel also has a feature that lets you compare and merge copies of a shared workbook. Before you enable this feature, make sure that you save your changes.
Here’s how you can do it: Select the Quick Access toolbar. Go to the drop-down for Choose commands from and select the All commands option. Look for the Compare and Merge Workbooks command in the list for commands and click Add. The icon for compare and Merge will appear in the Quick Access toolbar. Click the Compare and Merge
Workbooks icon. You may be asked to save the workbook if you hadn’t done so. A window will pop up to open files. Select the copies of the workbook to merge into the open copy or originally shared workbook. Click Ok. Your changes, as well as other users’ changes, will be combined which will show the cells with changes in different highlighted
colors. Related: convert Excel to Google Sheets How to Compare 2 Different Sheets in the Same Excel Workbook One way you can compare sheets in Excel is by using the formula method. Previously we showed you how to use the IF formula to compare two Excel files. Now we’ll show you how to use it to compare two sheets in the same workbook:
Open a new sheet by clicking the + sign at the bottom. In the new sheet, select a cell where you want to start the comparison. Enter the following formula: =IF(Sheet1!A3=Sheet2!A3,Sheet2!A3,"Sheetl:"&Sheet1!A3&"|Sheet2:"&Sheet1!A3) Make sure to replace “Sheetl” and “Sheet2” with the actual names of the sheets you want to compare. You
can also replace “A3” with the cell reference that represents the first cell you want to compare. Copy the formula to the rest of the cells. The comparison results will be displayed in the cells, indicating whether the values in the two sheets match or differ. Where the values don’t match, you will get the actual value from the first sheet and the second
sheet in two separate columns, but if they do match, you get one column with the common value. Frequently Asked Questions Can You Compare Two Excel Files for Differences? Yes, you can help you compare two Excel files for differences. There are a few different methods you can use to accomplish this task. We’ve shown you different methods like
using the view side-by-side option, using formulas, and using third-party tools. Can You Use VLOOKUP to Compare Two Excel Spreadsheets? Yes, you can use the VLOOKUP function in Excel to compare two Excel spreadsheets. The VLOOKUP function is commonly used for searching and retrieving data from a specific column in a table. You can
combine the Vlookup function with another function, like the IF function, to find differences in your Excel files, but a more straightforward method would be to use the IF formula as we have shown you above. Video Guide: Comparing Excel Files Here’s a guide I made that explores this topic in more detail. My YouTube channel has many more videos,
too. Bottom Line You don’t need to stare cross-eyed at different worksheets as you switch between windows anymore. With this tutorial, we’ve shown you how to compare two Excel files using several different methods. If you found this guide useful, you can also check out our premium templates, you’ll be sure to find something to suit your needs. Just
remember to use the code SSP to save 50% at checkout. Get Premium Templates Related: Now as you scroll down one Excel file, the other one will also be scrolled. Technically, you can control both books with one scroll bar. If you have more than two Excel files, to compare them by viewing Step 1) Open all the to-be-compared workbooks
simultaneously. Step 2) In any one of these workbooks, go to the View tab > Windows Group > View Side By Side button. Step 3) From the Compare Side by Side window, select any Excel file. Step 4) Go to the View tab > Windows Group > Arrange All button. Step 5) Choose how you want to compare the files (tiled might be a good option for multiple
workbooks). This method allows multiple workbook comparison in a seamless manner. Apart from different workbooks, sometimes all you want to do is compare two Excel sheets (or more) from the same workbook To do so: Step 1) Go to the View tab > Window group > New Window button. Excel will make a copy of this workbook for you and launch
it as a new window. Here onwards the steps are the same as for comparing two workbooks (because you now have two workbooks open). Step 2) Go to the View tab in any of the books > Window group > View Side by Side button. Step 3) Select the first sheet in the first book and the second sheet in the second book. Scroll in a synchronized manner
and compare both books conveniently by viewing them. If you have multiple sheets that you want to compare, create as many windows as many sheets you have (by re-clicking on the New Window button). Once you have the required number of windows launched, follow the same steps as explained above to compare multiple workbooks. The IF
function is a game changer in Excel, and I just love it for reasons I am going to explain in this section. If you have data spread across two sheets (or even two workbooks) and you only want to compare them to find out the differences, you probably don’t need to invest so much time viewing these sheets side by side 09 Just write up a formula and let
Excel find out the differences for you like a pro. For example, I have a dataset in Sheet 1 here. And a copy of this data (apparently) in Sheet2 here. However, I suspect some differences in both these datasets. To quickly compare these datasets from both these sheets to find these differences: Step 1) Launch a new sheet. Step 2) Activate a cell and
write the IF function as follows: Syntax Highlighter= IF (Step 3) Write the logical test that checks if cell A1 of Sheetl is equal to Al of Sheet2. Syntax Highlighter=IF(Sheet1!A1=Sheet2!A1,To refer to these cells from other sheets, just keep the formula open and go to the to-be-referred cell from the relevant sheet. Excel will automatically pick out its
reference. Or you can manually type it as SheetName + ! + Cell Reference. Check out this blog to learn more about How to Reference Tab & Sheet Names in Excel. Step 4) Write the value if true as an empty string (“”). Syntax Highlighter=IF(Sheet1!A1=Sheet2!Al, “”,Step 5) As the value if false, write the following string: Syntax
Highlighter"Sheetl: " & Sheetl!Al & " | " & "Sheet2: " & Sheet2!Al The first component is a text string (Sheetl: ) enclosed in double quotation marks. Then an ampersand (&) is used to connect this text string to the value in Cell A1 of Sheet 1 (Sheetl!Al). Again, an ampersand (&) and the text string ( | ) to create a comparison wall between the cell
values from both the sheets [][? An ampersand & and then the text string (Sheet2: ) connected with the cell value from Cell Al of Sheet 2 (Sheet2!Al) using an &. The text strings like a vertical bar (|) that I have used in the formula above are discretionary. You can replace them with anything of your liking. Or if you do not want to see how both the
values differ, you can simply replace the value if false with something simple like “Doesn’t Match” or “Different values” etc. This makes the IF function look like below: Syntax Highlighter=IF(Sheet1!Al1=Sheet2!A1,"","Sheetl: "&Sheet1!A1&" | "&"Sheet2: "&Sheet2!A1)All in all, this makes Excel check if the value in cell Al of Sheetl is equal to the
value of Cell Al in Sheet 2. If yes, good, you get an empty text string. If not, it will return the value from Cell Al of Sheet 1 compared to the value of Cell Al of Sheet 2. Step 6) Press Enter. Step 7) Drag this formula down and towards the right in line with the dimensions of the dataset in both your sheets (our is 5 columns and 4 rows) so I am
stretching this formula accordingly. Tada! For all those cells where the values in both the sheets differ, Excel presents you with a comparison of how both these sheets differ For example, for Cell B1, Excel says that this cell from both the sheets is different as this cell from Sheetl shows Blue and the same cell from Sheet2 shows Ball. Since we have
used an absolute reference for Cell Al, as we drag the formula around the cells, the cell reference updates, and all the cells from the dataset are compared. How cool is that! Conditional formatting is used to apply formatting to cells in Excel based on a specified condition. This can be used to compare two sheets to spot the differences between them. I
love how this method smartly picks out the differences between two sheets in a blink I have this data in the first sheet of my Excel file (it contains the personal details of a couple of people). And then in the next sheet, I have the same date (apparently) but there are some differences in both these sheets that are not evident just by looking like that.
The first sheet containing this data is named CF - Data I and the second sheet to which it is being compared is named CF - Data II. Let’s use conditional formatting to find out these differences. Step 1) Go to the sheet where you want the differences highlighted. Step 2) Select the cells that you want to be compared. If you want to compare the whole
sheet, select any cell of the sheet and press the Control key + A to select the whole sheet. Step 3) Go to the Home tab > Styles Group > Conditional Formatting > New Rule. Step 4) In the New Rule window, write the following rule: Syntax Highlighter=A1’CF - Data II’!A1 There are two sample workbooks named Book 1 and Book 2. Both workbooks
contain different datasets starting in the same cell in Column B. We can display these workbooks side-by-side and compare data visually for matches. Steps: Go to the first workbook Book 1. Under the View tab, select the View Side by Side command from the Window drop-down. Select Synchronous Scrolling under the View Side by Side option. Click
on the Arrange All option. A dialog box will appear. Choose the Vertical radio button from the options and press OK. The two workbooks are now displayed side-by-side for comparison. This method is helpful to compare a small amount of data visually and find matches side-by-side from two workbooks. As we’ve enabled Synchronous Scrolling, so if we
scroll down in a workbook the other workbook will follow. Method 2 - Compare and Match Data from 2 Worksheets by Viewing Side-by-Side in separate Workbook In this example there are two worksheets named Sheetl and Sheet2 within a single Excel workbook. Steps: Go to the View ribbon. From the Window dropdown, select New Window. The
sheets are now displayed as two different workbooks as shown in the following picture. Repeat the steps in the first method to compare data for Sheetl from the first workbook and Sheet2 from the second workbook and find matches visually. Method 3 - Match Data Side-by-Side from 2 Worksheets in Same Workbook and Return Outputs in Excel The
IF function will return the message Yes for the matched data and No for the non-matches. Steps: In cell C5 in Sheetl, enter the following formula: =IF(B5=Sheet2!B5,"Yes","no") Press Enter and use Fill Handle to autofill the rest of the cells in Column C under the Match header. Method 4 - Match Data Side-by-Side from 2 Worksheets in Excel with
Conditional Formatting Steps: Under the Home tab, select the option New Rule from the Conditional Formatting dropdown. A dialog box named New Formatting Rule will appear. Select the option Use a formula to determine which cells to format. In the Rule Description box, enter the following formula: In the Format Cells window, select the Fill tab.
Select a color that will highlight the matches from two worksheets. Press OK. The New Formatting Rule dialog box will display a preview of the highlighted cell with text at the bottom. Press OK. In Sheetl, the matches are highlighted with the specified color. Method 5 - Use VLOOKUP to Match Data from 2 Worksheets and Return Values in Excel The
first sheet contains a table with ID and Name and Address headers. The second worksheet contains the complete dataset. VLOOKUP can be used to find matches in the second worksheet (Sheet2), extract addresses for the corresponding matches, and display them in the first worksheet (Sheetl). As the VLOOKUP function will return a #N/A error if a
match is not found, we’ll combine the VLOOKUP function with the IFERROR function. This will return a customized message Not Found if the VLOOKUP function does not find a match in Sheet2. Steps: Enter the below formula in cell C5 of Sheetl: =IFERROR(VLOOKUP(B5,Sheet2!B5:C14,2,FALSE),"Not Found") Fill the entire column using the fill
handle to return the following outputs under the Address header in Sheetl. Method 6 - Apply INDEX-MATCH Formula to Match Data and Return Values after Comparing 2 Worksheets The INDEX function returns a value or reference from a cell in a given range, and the MATCH function returns the relative position of an item in an array that matches
a specified value in a specified order. Since the INDEX-MATCH formula will return an error if a match is not found, we’ll again use the IFERROR function to customize a return message for the non-matches. Steps: Enter the below formula in cell C5: =IFERROR(INDEX(Sheet2!B5:C14,MATCH(Sheet1!B5,Sheet2!B5:B14,0),2),"Not Found") Press Enter
and autofill the rest of the cells in Column C. Download Practice Workbook Match Data from Two Worksheets.xlsx
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